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Example 3.5.1. Normality tests. Pizza consumption.

Questions.

Load the data file pizza.gdt.

a. Run normality tests for the variables pizza and income.
b. Save the results as an icon to your session.

c. Interpret the results and save the session with the name dpizza.
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Example 3.5.1. Normality tests. Pizza consumption.

To run normality tests, go up to the Menu Bar and click

Variable -> Normality test

B grett @M

File Tools Data View Add Sample Variable Model Help

pizza.gdt Display values
ID # 4 Variable name ¢ Descriptive label Edit attributes )
0 const Set missing value code...
s I
2 p if female Normality test
3 HS =1 if highest degre¢ Frequency distribution...
4 C =1if highest degre¢ Estimated density plot...
5 P =1if highest degre¢ Boxplot
6 income annualincomeintt  Normal Q-Q plot...
7 age age in years Gini coefficient
8 |_piza = log of pizza Range-mean graph
9 sq_income = income squared
Time series plot
10 sq_age = age squared Panel plot...
1 H F*income Dmt root tests »
12 A income’age Comelogram.
13 pizzaT pizza/1000 .
Periodogram
Filter »
Undl  X-12-ARIMA analysis
w2 ExBE L 8 T e
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Example 3.5.1. Normality tests. Pizza consumption.

Ho :  variable comes from a normal distribution
H, : variable does not come from a normal distribution

The results are shown in the figures below.

gretl: normality test =8

BED0DADR

Test for normality of pizza:

Doornik-Hansen test = 7.21235, with p-value 0.0271555
Shapiro-Wilk W = 0.923332, with p-value 0.0098176

Lilliefors test = 0.160024, with p-value ~= 0.01

Jarque-Bera test = 3.3572, with p-value 0.186635

PI1ZZA
'ﬂ gretl: normality test = |8
B@E8DAB R
Test for normality of income:
Doornik-Hansen test = 53.2926, with p-value 2.67704e-012
Shapiro-Wilk W = 0.717651, with p-value 1.92003e-007
Lilliefors test = 0.2045, with p-value ~= 0
Jarque-Bera test = 191.033, with p-value 3.29463e-042
INCOME
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Example 3.5.1. Normality tests. Pizza consumption.

Results.
The output consists of a table with the statistics and the p-values.

The p-value is the estimated probability of rejecting the null hypothesis when it is
true.

Decision rule: if the p-value is smaller than a = 0.05, the null hypothesis is
rejected at a 5% significance level.

Conclusions:

e Most of the statistics indicate that the variable pizza does not come from a
normal distribution.

e All the statistics indicate that the variable income does not come from a
normal distribution.

Pilar Gonzélez and Susan Orbe | OCW 2014 Example 3.5 Univariate analysis



Example 3.5.1. Normality tests. Pizza consumption.

To save the results, go up to the menu bar in the normality test window and
click on the left icon (Save as...).

B4 gretl: normality test @M
(ZjISNERC =R
Testrmality of income:

Doornik-Hansen test = 53.2926, with p-value 2.67704e-012

Shapiro-Wilk W = 0.717651, with p-value 1.92003e-007

Lilliefors test = 0.2045, with p-value ~= 0

Jarque-Bera test = 191.033, with p-value 3.29463e-042
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Example 3.5.1. Normality tests. Pizza consumption.

To save the results in a file select the first option.

e [

Save text

) Save to session as icon

[ comce |[ ok J

To save the results as an icon to the session select the second option.

. gretl: save text m—eis]

Save text

Save to file

Cancel | [ oK
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Example 3.5.1. Normality tests. Pizza consumption.

By default, Gretl names the icon normality test. The results can be retrieved
double-clicking on this icon.

gretl: icon view (=] E |
Data info Data set Summary Correlations
N N B
=]=]
Model table Scalars Notes Graph page

normality test

Do not forget to save your session!
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Example 3.5.1. Normality tests. Visitors to Bilbao.

Questions.
Load the data file tourism.gdt.

a. Run normality tests for the three visitors variables.
b. Save the results as an icon to your Gretl session.

c. Interpret the results and save the session with the name dturismo.
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Example 3.5.1. Normality tests. Visitors to Bilbao.
gretl: normality test

CEERERN=R

Test for normality of TV:

Doornik-Hansen test = 16.5105, with p-value 0.000259892

Shapiro-Wilk W = 0.97452, with p-value 0.000277979

Lilliefors test = 0.0536142, with p-value ~= 0.09

Jarque-Bera test = 8.97476, with p-value 0.0112501

A greti: normality test (2| © jiS A gretl: normality test ESHIoR™>]

BEDADXR Be&oDaoR

Test for normality of SPV: Test for normality of FV:

Doornik-Hansen test = 12.946, with p-value 0.00154457 Doornik-Hansen test = 50.4057, with p-value 1.13379e-011
Shapiro-Wilk W = 0.97708, with p-value 0.000671266 Shapiro-Wilk W = 0.936897, with p-value 1.37183e-008
Lilliefors test = 0.0671755, with p-value ~= 0.01 Lilliefors test = 0.111786, with p-value ~= 0
Jarque-Bera test = 9.01476, with p-value 0.0110273 Jarque-Bera test = 28.4362, with p-value 6.68601e-007

Result.

It may be concluded, at the 5% significance level, that the series of visitors do not come
from a normal distribution.

Do not forget to save these results as icons to, your session!
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Example 3.5.1. Normality tests. Visitors to Bilbao.

The saved results may be retrieved by clicking on the icon windows in the normality test

window.

A gret: normality test

e

Doornik-Hanse

E——
B8 DA B Main window
Test for normz || normality test

) Amange

Shapiro-Wilk W = 0.936897,

Lilliefors test = 0.111786, with p-value ~= 0

Jarque-Bera test = 28.4362, with p-value 6.68601e-007

ith p-value 1.1337%e-011

with p-value 1.37183e-008

Or from the session (there is one icon for each test).

gretl: icon view

(2| jS)

B

Data info

Model table

normality test

Ho

Data set Summary

Scalars Notes
normality te...  normality te...

(el

Correlations

=28

Graph page
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Example 3.5.2. Frequency distribution. Pizza consumption.

Questions.

Analyse the frequency distribution of the variables included in the data file

pizza.gdt.

a. Obtain the frequency distribution of the variable pizza.

b. Obtain the graph of the frequency distribution and run the tests against the
normal and gamma distributions for the variable pizza.

c. Save the numerical results as icons to your Gretl session and the graphs in
Word format.

d. Comment on the results.

e. Save the session.
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Example 3.5.2. Frequency distribution. Pizza consumption.

To obtain the frequency distribution and its plot, highlight the variable of interest
and select the option Frequency distribution from the Variable pulldown menu.

Variable -> Frequency distribution...

gret | E) e
File Tools Data View Add Sample Variable Model Help
pizza.gdt Display values
ID # 4 Variable name 4 Descriptive label Edit attributes 1
0 const Set missing value code...
1 piza EITTEETEY  Summary statitcs I
2 F =1if female Normality test
3 HS =1if highest degre¢  Frequency distribution...
4 C =1if highest degre¢ Estimated density plot...
5 P =1 if highest degre¢ Boxplot
6 income annual income in th Normal Q-Q plot...
7 age age in years Gini coefficient
8 |pizza = log of pizza Range-mean graph
9 sqincome = income squared
Time series plot
10 sq_age = age squared
. Panel plot
1 A Ffincome Uikt oot tests
12 A income*age iz
~ . Correlogram
13 pizzaT pizza/1000

Periodogram

Alioro o bichlioh bo hlo o ptaoro ah
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Example 3.5.2. Fr y distribution. Pizza consumption.

From the dialog box you will tell Gretl the number of bins you want to use and
the type of output you want to get.

gretl: frequency distribution &

pizza (n = 40, range 0 to 590)

Minimum value, left bin: -0.983

Bin width:

© Show data only
Test against normal distribution

Test against gamma distribution

[¥] show plot

Hep || cCemce |[ ok
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Example 3.5.2. Frequency distribution. Pizza consumption.

By default, Gretl calculates the number of bins depending on the range of values and shows both the

numerical results for the frequency distribution and its plot, but you may select any other number of bins. It is

also possible to change the number of bins by writing the minimum value of the left bin and its width.

gretl: frequency distribution |t

pizza (n = 40, range 0 to 590)

® [Number of bins:| 7
Minimum value, left bin: -0.983

Bin width: 98333

©

Show data only
Test against normal distribution

Test against gamma distribution

<

show plot

[ Bep ][ conca |

It is possible to run tests against the normal distribution or the gamma distribution.
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grett: frequency distribution (=<

pizza (n = 40, range 0 to 590)

® [Number of bins:] 7
Minimum value, left bin: 0983
Bin width: 98.333
© Show data only
Test against normal distribution
Test against gamma distribution

] show plot

e -
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Example 3.5.2. Frequency distribution. Pizza consumption.

The output consists of a table of numerical results with information on:

e the variable, number of observations and bins, the mean and the standard
deviation.

e the bounds of each interval.
e the midpoint of the interval.
e the frequency.

e the relative frequency.

e the cumulative frequency.

and the plot of the frequency distribution.
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Example 3.5.2. Frequency distribution. Pizza consumption.

Numerical results (default). Pizza.

gretl: frequency distribution @M
BeDADX

Frequency distribution for pizza, obs 1-40
number of bins = 7, mean = 191.55, sd = 155.881

interval midpt frequency rel. cum.

< 49.167 0.0000 7 17.50% 17.50% *x%##x
49.167 - 147.50 98.333 14 35.00% S2.50% WHRhkhRhkAiw
147.50 - 245.83 196.67 5 12.50% 65.00% ***¥
245.83 - 344.17 295.00 7 17.50% 82.50% **xwxxw
344.17 - 442.50 393.33 5 12.50% 95.00% ***%
442.50 - 540.83 491.67 1 2.50% 97.50%

>= 540.83 590.00 1 2.50% 100.00%
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Example 3.5.2. Frequ

Frequency distribution plot (default). Pizza.

gretl: graph

acn|wiin

Relative frequency

o 100 200 300 400
pizza

500 600

Right-click on graph for menu

GoRZE X
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Example 3.5.2. Frequency distribution. Pizza consumption.

Frequency distribution with tests.

B gretl: frequency distribution @ gretl: frequency distribution [
pizza (n = 40, range 0 to 590) pizza (n = 40, range 0 to 590)
© Number of bins: 7 = @ Number of bins: 7 =
Minimum value, left bin: -0.983 . Minimum value, left bin: -0.983
Bin width: Bin width: 98.333
Show data only Show data only
@ Test against normal distribution! Test against normal distribution
) Test against gamma distribution © Test against gamma distributio
[¥] show plot [¥] show plot
[ Help ] [ Cancel ] [ oK ] [ Help ] [ Cancel ] [ OK ]
Against the normal (Doornik-Hansen) Againts the gamma (Lock)
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Example 3.5.2. Frequency distribution. Pizza consumption.

The numerical results are shown in the figures below.

retl: frequency distributi o8
B et frequency distibuton e s

Bl —
GEERERS Beoa®x
Frequency distribution for pizza, obs 1-40

unber of bins = 7, mean = 181.55, sd = 155.881 for pizza, obs

= 191.55, sa s.881
interval midpe  frequency  rel. cum. e fremency et -
< 0.00000 17.50%  17.50% *wwaxs o om000
49.167 - 98.333 1 35.008 52,508 *xwmwxaxarar

12,508 65.00% *exx

5
"
147.50 - 245.83  196.67 H
2 7 17.508  82.50% wwswss
5
1
1

12,508 95.00% *exx
2,508 97.50%
2.50% 100.00%

rmal distribution:
alue 0.02716

Against the normal (Doornik-Hansen) Against the gamma (Lock)
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Example 3.5.2. Frequency distribution. Pizza consumption.

The frequency plots appear in the figures below.

B grett groph Lo - B arett graph = =

0.008

0.004

pizza P—
nionsssEes) — gamma(1.51,126.85) ——

0.0035 0.0035

0.003 0.003

0.0025

0.002

Density
ensity

o.0015

0.001

0.0005

°

600

<00
Right-cick on gaph formens HOBP® %

3830002567 Right-click on graph for menu HeBW2D X [

Against the normal (Doornik-Hansen) Against the gamma (Lock)
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Example 3.5.2. Fr y distribution. Pizza consumption.

To save the results as icons to the session go up to the menu bar in the
frequency distribution window and click on the left icon. The name by default is
frequency di....

gretl: icon view E@&
Data info Data set Summary Correlations
N N B
=]=]
Model table Scalars Notes Graph page
frequency di... frequency di... frequency di...
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Example 3.5.2. Frequency distribution. Pizza consumption.

To save the plots in Word format, right-click on each plot and select the option
Copy to clipboard in the pulldown menu. You may choose whether you want to
save the plot in colour. Then you can paste the plot to a Word file.

gretl: graph ==
0.3s | Save as Windows metafile (EMF)... > |
Save 25 PNG...
Save as postscript (EPS)...
03 Save as PDF.. -
Copy to clipboard »| color
Zoom... monochrome
0.25 Print » 4
g Display PDF
E Edit
& o2 Close
..
=
]
3
g

3 100 200 300 400 500 600
pizza
11103614 Right-click on graph for menu EeR B %
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Example 3.5.2. Frequency distribution. Pizza consumption.

The results about the frequency distribution of variable income are shown below.

I gretl frequency distribution (2] © [
BE20aAD R

requency distribution for income, obs 1-40
number of bins = 7, mean = 5$5.8025, sd = 51.1661

interval midpt  frequency  rel. cum.

< 46.800  23.400 24 60.00%  60.00%
46.800 - 93.600  70.200 10 25.00%  85.00%
93.600 - 140.40  117.00 4 10.00%  95.00%
140.40 - 187.20  163.80 1 2.50%  97.50%
187.20 - 234.00  210.60 0 0.00%  97.50%
234.00 - 280.80  257.40 0 0.00%  97.50%

>= 280.80  304.20 1 2.50% 100.00%

B et groph [P
[ . .
0
os
& oal
g
£
i oost
osf
. —
‘ 271400202 Right-click on graph for menu eRes - NEX=R ]|
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Example 3.5.2. Frequency distribution. Pizza consumption.

Results.

e The frequency distribution of the variable pizza consumption shows that 35 %
of the individuals in the sample spend around $98.333 in pizza and that 5% of
the individuals spend between 216.45 and 264.55 dollars.

e The variable pizza does not come from a normal distribution but there is
evidence in the sample that it comes from a gamma distribution.

e 60 % of the individuals in the sample have an income lower than 23.4
thousands of dollars per year, while there is only one individual in the sample
with an income higher than 280.8 thousands of dollars.
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Example 3.5.2. Frequency distribution. Visitors to Bilbao.

Questions.

Analyse the frequency distribution of the variables included in the data file
tourism.gdt.

a.

Obtain the frequency distribution for the variable T'V. Save the results as an
icon to the session and the plot in Word format.

Obtain the frequency distribution for the variable foreign visitors.

Augment the default number of bins by ten units and save the results.

. Reduce the default number of bins to five units and save the result.

. Comment on the results.
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Example 3.5.2. Frequency distribution. Visitors to Bilbao.

Numerical results (default). Total Visitors.

gretl: frequency distribution E@&

BEDADXR
Frequency distribution for TV, obs 1-238
number of bins = 15, mean = 39601.3, sd = 15290.7
interval midpt frequency rel. cum.
< 15106. 12623. 4 1.68% 1.68%
15106. - 20072. 17589. 24 10.08% 11.76% ***
20072. - 25037. 22554. 22 9.24% 21.01% ***
25037. - 30003. 27520. 23 9.66% 30.67% **~
30003. - 34969. 32486. 24 10.08% 40.76% **~
34969. - 39934. 37452. 36 15.13% 55.88% wwwww
39934. - 44900. 42417. 25 10.50% 66.39% **~
44900. - 49866. 47383. 14 5.88% 72.27% **
49866. - 54832. 52349. 23 9.66% 81.93% *ww~
54832. - 59797. 57314. 16 6.72% 88.66% **
59797. - 64763. 62280. 10 4.20% 92.86% *
64763. - 69729. 67246. 9 3.78% 96.64% *
69729. - 74694. 72212. 4 1.68% 8.32%
74694. - 79660. 77177. 3 1.26% 99.58%
>= 79660. 82143. 1 0.42% 100.00%

Do not forget to save these results as icons to your session!
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Example 3.5.2. Frequency distribution. Visitors to Bilbao.

Frequency distribution plot (default). Total visitors.

B oreti: graph e=nee

T T T T T T T T
0.16 - 4

Relative frequency

[}
10000 20000 30000 40000 50000 60000 70000 80000
™

| Right-click on graph for menu BoeBRZE X

Do not forget to save this plot in Word format!
[} = =
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Example 3.5.2. Frequency distribution. Visitors to Bilbao.

Numerical results (default). Foreign Visitors.

“ gretl: frequency distribution @E&

BEEODADX
Frequency distribution for FV, obs 1-238
number of bins = 15, mean = 12730.9, sd = 7740.68
interval midpt frequency rel. cum.
< 2827.8 1s518.0 10 4.20% 4.20% *
2827.8 - 5447.5 4137.6 39 16.39% 20.59% *xx*x*x
5447.5 - 8067.1 6757.3 25 10.50% 31.09% ***
8067.1 - 10687. 9376.9 31 13.03% 44.12% ****
10687. - 13306. 11997. 46 19.33% 63.45% *xwxaw
13306. - 15926. 14616. 21 8.82% T72.27% ***
15926. - 18546. 17236. 16 6.72% 78.99% **
18546. - 21165. 19856. 12 5.04% 84.03%
21165. - 2378S. 22475. i3 5.46% 89.50% *
23785. - 26405. 25095. 9 3.78% 93.28% *
26405. - 29024. 27714. 8 3.36% 96.64% *
29024. - 31644. 30334. 3 1.26% 97.90%
31644. - 34264. 32954. 2 0.84% 98.74%
34264. - 36883. 35573. 2 0.84% 99.58%
>= 36883. 38193. 1 0.42% 100.00%
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Example 3.5.2. Frequency distribution. Visitors to Bilbao.

Frequency distribution plot (default). Foreign visitors.

A gret: graph L=l

T T T T T T T T T

Relative frequency

o 5000 10000 15000 20000 25000 30000 35000 40000
Fv

Right-click on graph for menu R JEASR 4
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Example 3.5.2. Frequency distribution. Visitors to Bilbao.

Numerical results (25 bins). Total Visitors.

I gretk: frequency distribution [ESHHel >

B8 D
Frequency distribution for TV, obs 1-238 -
number of bins = 25, mean = 32601.3, sd = 15290.7
interval midpt frequency rel. cum.
< 14071. 12623. 3 1.26% 1.26%
14071. - 16968. 15520. 5 2.10% 3.36%
16968. - 19865. 18416. 18 7.56%  10.92% ==
19865. - 22761. 21313. 9 3.78% 14.71% *
22761. - 25658. 24210. 17 7.14%  21.85% ==
25658. - 28555. 27106. 13 5.46%  27.31%
28555. - 31451. 30003. 14 5.88%  33.19% =~
31451. - 34348. 32900. i3 5.46% 38.66% *
34348. - 37245. 35796. 21 8.82%  47.48% **+
37245. - 40141. 32693, 21 8.82%  56.30% ==~ 2
40141. - 43038. 41590. 17 7.14%  63.45% =~
43038. - 45935. 44486, 9 3.78%  67.23% ~
45935. - 48831. 47383. 10 4.20% 71.43% *
48831. - s51728. 50280. 14 5.88%  77.31% **
51728. - 54625. 53176. ] 3.78%  81.09% ~
54625. - 57521. 56073. 11 4.62%  85.71% *
57521. - 6041s8. 58970. 8 3.36% 89.08% *
60418. - 63315. 61866. 7 2.94% 92.02% *
63315. - 66211. 64763. 6 2.52%  924.54%
66211. - 69108. 67660. 5 2.10%  26.64%
69108. - 72005. 70556. 2 0.84%  97.48%
72005. - 74901. 73453. 4 1.68% 99.16%
74901. - 77798. 76350. o 0.00%  99.16%
77798. - 20695. 79246. 1 0.42%  99.s8% —
>= 80695. 82143. 1 0.42% 100.00% <
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Example 3.5.2. Frequency distribution. Visitors to Bilbao.

Frequency distribution plot (25 bins). Total Visitors.

B grett: graph e

Relative frequency
°
o
&

o

10000 20000 30000 40000 50000 60000 70000 80000
™v

| Right-click on graph for menu B2 X

u}
)
I
il
it
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Example 3.5.2. Frequency distribution. Visitors to Bilbao.

Numerical results (5 bins). Total Visitors.

B grett: frequency distribution (e E) S
BEDADXR

Frequency distribution for TV, obs 1-238
number of bins = 5, mean = 39601.3, sd = 15290.7

interval midpt frequency rel. cum.
< 21313. 12623. 32 13.45% 13.45% wwww
21313. - 38693. 30003. 88 36.97% 50.42% WHRARARARNNNN
38693. - 56073. 47383. 79 33.19% 83.61% WANARARNNAW
56073. - 73453. 64763. 35 14.71% 98.32% wwwww
>= 73453. 82143. 4 1.68% 100.00%
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Example 3.5.2. Frequency distribution. Visitors to Bilbao.

Frequency distribution plot (5 bins). Total Visitors.

gretl: graph w—.

[N S T T T T =

0.35

0.3

Relative frequency
o
9

1] 20000 40000 60000 80000
™

Right-click on graph for menu (RN | =P
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Example 3.5.2. Frequency distribution. Visitors to Bilbao.

Results.

e The frequency distribution of the variable F'V suggests that it may come from a
bimodal distribution. The two modes contain 18.25 % of the foreign visitors. It seems
that there are two relevant points in time for the arrival of foreign visitors.

e The frequency distribution of the variable 7'V obtained with 25 bins shows that the
first part of the frequency distribution is not as homogeneous as it looked like when
calculated with only 15 bins.

e On the other hand, the frequency distribution of the variable T'V obtained with 5
bins is too smooth. It is not possible to see any detail and it seems much more
homogeneous than it really is.

e |t is recommended to use the default value of bins if you are not an expert in
calculating the optimal number.
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Example 3.5.2. Frequency distribution. Simulation.

Questions.

a. Simulate cross-section data: 50 observations from a normal distribution with zero
mean and standard deviation 1. Denote this variable by V' N. Save the simulated data
in the file Sim50.gdt.

a.l. Plot the standard normal distribution and save the graph in pdf format.

a.2. Obtain the frequency distribution for the variable V' N and run the the tests against the normal and
gamma distributions. Save the graphs in pdf format.

b. Simulate cross-section data: 1000 observations from a Chi-squared distribution with
10 degrees of freedom. Denote this variable by VX . Save the simulated data in the
file Sim1000.gdt.

b.1. Plot the selected Chi-squared distribution and save the graphs in pdf format.

b.2. Obtain the frequency distribution for the variable VX and run the the tests against the normal and
gamma distributions. Save the graphs in pdf format.

c. Comment on the results.
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Example 3.5.2. Frequency distribution. Simulation.

Look up Example 3.2.4 to refresh how to simulate data.

To plot the standard normal distribution, go up to the Menu Bar and click

Tools -> Distribution graphs

gretl: distribution graphs =B

[normat | ¢ [ chi-square| F [ binomial| poisson | weibuil

mean 0
std. deviation |1

COF instead of density

Close | oK
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Example 3.5.2. Frequency distribution. Simulation.

To save this plot, right-click on the graph and select the option Save as PDF...
from the pulldown menu. This yields a dialog box that enables us to edit the

graph.

et graph (B grett graph - =
o, 3 N, 5
o - 0 —
B orett save graph
035 oas POF fle
o3 03
025 02s
ine width foctor (10 -
o 02
(o sem10)
o oxs ® color
monochrome.
01 01
/ prevew | [ sove IR\
o.0s / = \
008 \
/ AN
o N -
s a T 3 0 s s " ) £ I 5 T B B B s
335703590 Zeom|@ x® 213803182 Right-click on graph for menu o=l NEASE
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Example 3.5.2. Frequency distribution. Simulation.

Frequency distribution plots and normality test (Doornik-Hansen). V.N.

' ' VN pmmm
N(-0.0060851,1.0994)

0.4

Test Istatistic for nlormality:
Chi-square(2) = 1.452 [0.4838]

Density

it
«

£
€

Do not forget to save this plot in pdf format!

Example 3.5 Univariate analysis
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Example 3.5.2. Fr y distribution. Simulation.

x?(10) distribution plot.

Chi-square(10) ——

0.05 |-
| P —— e B

novmall t| chi-square | F Ibmomiall po-sson[ weibull /

Do not forget to save this plot in pdf format!
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Example 3.5.2. Frequency distribution. Simulation.

Frequency distribution plot and normality test (Doornik-Hansen). V' X.

0.1

Test statistic for norr ' ' ' ' V>I( —

Chi-square(2) = 164. N(10.009,4.5135) ——

0.09

0.08

0.07

0.06

0.05

Density

0.04

0.03

0.02

0.01

VX

Do not forget to save this plot in pdf format! _  _
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Example 3.5.2. Frequency distribution. Simulation.

Frequency distribution plot and gamma test (Lock). VX.

' VX

Test statisti
z=10.532]

Density

Do not forget to save this plot in pdf format!
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Example 3.5.2. Frequency distribution. Simulation.

Results.

e Comparing the plot of the standard normal distribution and the frequency
distribution of the variable VN, it may be concluded that they do not look very
similar. Nevertheless, the p-value of the normality test is larger than 0.05 meaning
that there is evidence in the sample that the variable VN comes from a normal
distribution at the 5 % significance level. It has not been possible to carry out the
test against the gamma distribution because Gretl detects that there are some
negative values in the sample and therefore the test makes no sense.

e Analysing the frequency distribution of the variable V' X, it may observed that it does
not look like a normal distribution but it is quite similar to a gamma distribution.
The tests reach the same conclusion: the p-value obtained in the normality test is
smaller than 0.05 and the p-value obtained in the gamma test is larger than 0.05.
Therefore, there is evidence in the sample that the variable VX comes from a
gamma distribution at the 5% significance level. This result was expected since the
Chi-squared distribution belongs to the class of gamma distributions.

e Bear in mind that your simulated data are going to be different from ours. Therefore,
you will obtain different frequency distributions and your conclusions might not be

the same.
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Example 3.5.3. Estimated density plot. Pizza consumption.

Questions.

Load the data file pizza.gdt.
a. Estimate the density function of the variables pizza and income.

b. Estimate the density function of the variable age using the Gaussian and the
Epanechnikov kernels.

c. Comment on the results. Save the session.
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Example 3.5.3. Estimated density plot. Pizza consumption.

To obtain the estimated density plot, select the option Estimated density plot...
from the Variable pulldown menu.

Variable -> Estimated demnsity plot ...

gretl @E&
File Tools Data View Add Sample Variable Model Help

pizza.gdt Display values

ID # 4 Variable name 4 Descriptive label Edit attributes 4
0 const Set missing value code...

Summary satsics I
2 F =1 if female Normality test
3 Hs =1if highest degre¢  Frequency distribution...
4 C =1if highest degre¢  Estimated density plot...
5 P =1 if highest degre¢ Boxplot
6 income annual income in th Normal Q-Q plot...
7 age age in years Gini coefficient
8 |piza = log of pizza Range-mean graph
9 sqincome = income squared
10 sq_age = age squared
1A F*income N
12 1A income*age
13 pizzaT pizza/1000

>
Undi

W2 E s~ BE L B
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Example 3.5.3. Estimated density plot. Pizza consumption.

The dialog box offers two kernel options.

B gt @Eﬂ
File Tools Data View Add Sample Variable Model Help
pizza.gdt
ID # 4 Variable name 4 Descriptive label Ll
0 const
1 annual density estimation options |03
2 F =Litfel | o) Gaussian kemel
3 HS =1 if hi
4 C =1if hig |~ Epanechnikov kernel
5 P =1 if hid |
6 income annualld bandwidth adjustment factor: 100 =
7 age ageiny |
8 |_piza =logof | [ Help ] [ Cancel ] [ oK
9 sqincome = incon*
10 sqage = age squared
n A F*income
12 1A income*age
13 pizzaT pizza/1000

Undated: Full range 1 - 40

B2AE~RAEL B0
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Example 3.5.3. Estimated density plot. Pizza consumption.

Estimated density plot (default bandwidth). pizza. Gaussian kernel.

grett: graph [ESHEEE™> ]
Estimated density of pizza
0.003 T T T T T T T
Gaussian kernel
bandwidth = 67.0846
0.0025 |- 1
//
0.002 7 R
0.0015 - I R
0.001 -
0.0005 |- 1
~
o 100 200 300 400 500 600 700 800
2760001421 Right-click on graph for menu EE=R JEASE 1

Pilar Gonzélez and Susan Orbe | OCW 2014 Example 3.5 Univariate analysis



Example 3.5.3. Estimated density plot. Pizza consumption.

Estimated density plot (default bandwidth). income. Gaussian kernel.

B greti: groph = S
Estimated density of income
0.014 T T T T
/ \\ Gaussian kernel
/ \ bandwidth = 14.1007
o012 | 4
0.01 4
0.008 [f \ 4
0.006 - \ B
0.004 \\ 4
0.002 - \\ 4
\
\
o — _
50 100 150 200 250
l Right-click on graph for menu Eg=R JEASE 4
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Example 3.5.3. Estimated density plot. Pizza consumption.

Estimated density plot (default bandwidth). age. Gaussian kernel.

grett: graph oo )
Estimated density of age
0.035 T T T T T T
Gaussian kernel
o bandwidth = 4.41254
0.03 / \ 1
\
/ \\
0.025 [ / N\ 1
N\
\\
0.02 ff \ ]
\
\
\
0.015 - \ E
\
0.01 | \\ 1
\
\
0.005 - \ 1
) " i 1 " 1 —
20 30 40 50 60 70
Right-click on graph for menu EoRARZB X
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Example 3.5.3. Estimated density plot. Pizza consumption.

Estimated density plot (default bandwidth). age. Epanechnikov kernel.

grett: graph [ESREE ™)
Estimated density of age
0.035 — T T T
Epanechnikov kernel
bandwidth = 4.41254
0.03 | -
0.025 - /

20 30 40 50 50 70
Right-click on graph for menu RN JEASE
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Example 3.5.3. Estimated density plot. Pizza consumption.

Results.

e Analysing the estimated density functions of the variables pizza and income, it
may be concluded that both are asymmetric to the left, that is the values close
to the ordinate are more probable.

In the case of the variable pizza, there is a second mode, a smaller one, around
$350. This density function seems to be bimodal.

In the case of the variable income, there is a high probability of being around
50 thousand of dollars while the probability of income being higher than 100
thousands of dollars is quite low.

e The Gaussian and Epanechnikov kernels produce the same results
asymptotically. However, comparing the estimated density functions of the
variable age using these two kernels, it may be observed that the estimated
density function obtained using the Gaussian kernel is smoother. This result is
due to the sample size and the automatic selection of the bandwidth h.
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Example 3.5.3. Estimated density plot. Visitors to Bilbao.

Questions.
Load the data file tourism.gdt.

a. Estimate the density function of the variables SPV and F'V using the
Gaussian kernel.

b. Estimate the density function of the variable I PIR using the Gaussian kernel
for several bandwidths: the default, the minimum and the maximum.

c. Discuss and compare the results. Save the session.
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Example 3.5.3. Estimated density plot. Visitors to Bilbao.

Estimated density plot (default bandwith). SPV. Gaussian kernel.

B greti: graph

(o] oo

4.5e-005

Estimated density of SPV

4e-005 |-

3.5-005 [

3e-005 -

2.5€-005 -

2e-005 [

1.5e-005

1e-005 [

S5e-006 -

0

Gaussian kernel

bandwidth = 2480.08

15000

20000 25000 30000 35000 40000 45000 50000 55000

R NE

=

Right-click on graph for menu
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Example 3.5.3. Estimated density plot. Visitors to Bilbao.

Estimated density plot (default bandwith). F'V. Gaussian kernel.

B4 greti: graph O [
Estimated density of FV
6e-005 T T T T T T T T
Gaussian kernel
bandwidth = 2331.88
5e-005 [ A B
/ \
/ \
4e-005 |- \
J‘ \
[
[
3e-005 [/ 1
2e-005
1e-005 1
L L L L L L L \'r
5000 10000 15000 20000 25000 30000 35000 40000
164931.154¢-005 Right-click on graph for menu OR R JEAS]
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Example 3.5.3. Estimated density plot. Visitors to Bilbao.

Estimated density plot (default bandwith). IPIR. Gaussian kernel.

B4 grett: graph SRR

Estimated density of IPIR

Gaussian kernel

/ \ bandwidth = 1.76418
0.06 [ / \
/ \

/ \
/ \
0.05 [ /

\
0.03 / \ g
/ \
/ \
0.02 / 1
0.01 |

0 10 20

-20 -10

Right-click on graph for menu
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Example 3.5.3. Estimated density plot. Visitors to Bilbao.

Estimated density plot (maximum bandwith). IPIR. Gaussian kernel.

grett: graph [ESHEEE™>

Estimated density of IPIR
0.045 T T

Gaussian kernel
bandwidth = 7.05671

0.025 [ 9

0.015 |- 4

° L L L L L

20 -10 0 10 20
Right-click on graph for menu G eRARZE X
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Example 3.5.3. Estimated density plot. Visitors to Bilbao.

Estimated density plot (minimum bandwith). TPIR. Gaussian kernel.

] gretl: graph

(o] ]

Estimated density of IPIR

Gaussian kernel
bandwidth = 0.441044

-12.21 0.003462

Right-click on graph for menu
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Example 3.5.3. Estimated density plot. Visitors to Bilbao.

Results.

e The estimated density functions of the variables SPV and F'V are both
bimodal. In the case of SPV the two modes are quite different, one being
much higher than the other. In the case of F'V both modes are similar.
Comparing both estimated density functions, it may be concluded that the
probability of having a high number of visitors is bigger when they come from
Spain.

e Comparing the three density functions estimated for I PIR, it may be
concluded that the maximum bandwidth makes the estimated density function
look Gaussian while the minimum bandwidth produces a much more irregular
density function. Therefore, if you are not an expert in choosing the bandwidth,
it is recommended to use the default bandwidth calculated by Gretl.
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© 3.5.4. Boxplot.
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Example 3.5.4. Boxplot.

Questions.

Load the data file pizza.gdt into Gretl to obtain the boxplots for several
variables.

a. Obtain the simple boxplot for the variable pizza, including the confidence
interval for the median.

b. Obtain the simple boxplot for the variables pizza, income and age.

c. Obtain a factorized boxplot for the variable pizza using the variable F' as factor.

d. Comment on the results.
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Example 3.5.4. Boxplot.

To obtain a boxplot, highlight the variable of interest, go up to the Menu Bar and
click Variable -> Boxplot

gretl (2] jmS]
File Tools Data View Add Sample Variable Model Help

pizza.gdt Display values

ID # ¢ Variable name ¢ Descriptive label Edit attributes |
0 const Set missing value code...

Summry satsics I
2 F =1if female Normality test
3 HS =1 if highest degre¢ Erequency distribution...
4 C =1if highest degre¢  Estimated density plot...
5 P =1if highest degre¢  Boxplot
6 income annual income in th Normal Q-Q plot...
7 age age in years Gini coefficient
8 |piza = log of pizza Range-mean graph
9 sqincome = income squared
10 sq_age = age squared
1 A Ffincome A
12 1A income*age
13 pizzaT pizza/1000

Alternatively, highlight the variable of interest, right-click and select the option Boxplot
from the pulldown menu.
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Example 3.5.4. Boxplot.

The dialog box offers three boxplot options.

B ot = B %
File Tools Data View Add Sample Variable Model Help
pizza.gdt
ID # 4 Variable name 4 Descriptive label ‘
0 const
1 piza annual pizza expenditure, $
2 F =1 if fe
RS =T “ gretl: define graph
4 cC =1if hid | © [Simple boxp!
5 P =1if hi With confidence interval for median
6 income annual i
7 age agein Factorized
8 | piza =log
9 sq_income = incon)|
10 sq age = age sq
1 A F*income
12 1A income*age
13 pizzaT pizza/1000

Undated: Full range 1 - 40

@BZOE~BARL 2 3B B
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Example 3.5.4. Boxplot.

Simple boxplot. pizza.

gretl: graph o e o

pizza

400

Right-click on graph for menu CGoeRAZB X
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Example 3.5.4. Boxplot.

Boxplot with confidence interval for the median. pizza.

Bl grett: graph [ESREEE >
pizza

600 -
500
400
300
200
100
ol

12778 Right-click on graph for menu =R JEASE 3

It should be noted that there is no information about the sample mean in this boxplot.
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Example 3.5.4. Boxplot.

To obtain a boxplot for several variables on a single graph, go up to the Menu Bar

and click

View -> Graph specified vars -> Boxplots...

B ot | )
File Tools Data View Add Sample Variable Model Help
pizza.gdt Icon view l
# 4 Variabl 4
L ariable namy Graph specified vars 4 Time series plot.
ot Multiple graph: »| o xvseat
e ot
2 F Summary statistics X-V w, - imPu s .
3 HS Correlation matrix X-V wnh I :eparatlon...
4 C Cross Tabulation B‘ v:m ot
5 P Principal components ;oxp cfts..,
6 income Mahalanobis distances EEmmlrnne
Q-Q plot...
a0 3D plot.
8 |_piza S
9 sq_income = income squared
10 sq_age = age squared
n A Ffincome
12 income*age
13 pizzaT pizza/1000
Undated: Full range 1 - 40
@BROE~BEL 4 8BD
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Example 3.5.4. Boxplot.

Select the desired variables: pizza, income and age.

[ B4 grett: boxplots &

Specify variables to plot:

pizza income age

[] Show interval for median

Hep |[ cenca ][ ok

If you want to include the confidence intervals for the medians, mark
show interval for median.
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Example 3.5.4. Boxplot.

Boxplot for specified variables.

gretl: graph SRR

600 -

100

pizza income age

1801321 Right-click on graph for menu E0oRAZB X
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Example 3.5.4. Boxplot.

Select the third option in the dialog box to obtain a factorized boxplot.

Hoet =8 %
File Tools Data View Add Sample Variable Model Help
pizza.gdt
ID # ¢ Variable name ¢ Descriptiye label A
0 const A grett: define graph
1 piza annual
2 F 1 f Simple boxplot
3 HS =1 if hi With confidence interval for median
4 C =1 if hi
5 P =1f hi e
6 income annual Cancel
7 age agein
8 |piza = log of
9  sq_income = income squared
10 sq_age = age squared
n A Ffincome
12 1A income*age
13 pizzaT pizza/1000
Undated: Full range 1 - 40
@2OE~BAEL A aBD
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Example 3.5.4. Boxplot.

Select the variable to plot and the variable that will be used as factor. It has to
be a discrete variable. In this case, select F' (female).

gretl: define graph E‘M

factorized boxplot

pizza
F
HS

income
age
|_pizza
sq_income Factor (discrete)
sq_age
F1

1A
pizzaT

Variable to plot

Hep | [ cear || cance || ok
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Example 3.5.4. Boxplot.

Factorized boxplot (factor F). pizza.

B et graph [ESHEE >

Distribution of pizza by F

pizza
w
=1
5}
T

[ 1

Right-click on graph for menu ER=R HEASR
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Example 3.5.4. Boxplot.

Results.

e Looking at the first boxplot of pizza, it may be concluded than the median is smaller
than the sample mean. But it has to be taken into account that only the point
estimates of the median and the mean are plotted. The second boxplot of variable
pizza gives more information because it includes the confidence interval for the
median. In this graph, it can be observed that the sample mean is inside the
confidence interval for the median. Therefore, there are not significant differences
between the sample mean and the median.

e When the boxplots of pizza, income and age are shown on the same graph, it is
difficult to compare the results because the units of measurement are quite different:
dollars, thousands of dollars and years. Therefore, it may be concluded that it is only
sensible to represent boxplots of several variables on a single graph if the units of
measurement are similar.

e Analysing the factorized boxplot of pizza using variable F' (1 if female) as factor, it
may be concluded that women consume less pizza than men: both the sample mean
and the median are smaller for women, the first quartile for women is similar to the
third quartile for men and the IQ range is much narrower for women than for men.
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Example 3.5.4. Factorized boxplots.

Questions.

Load the data file pizza.gdt into Gretl.
a. Create three discrete variables depending on age as follows:
e groupl: clients who are less than thirty one years old.

e group2: clients who are over thirty years old and less than forty one years
old.

e group3: clients who are over forty years old.

b. Obtain a factorized boxplot for the variable pizza, using as factor the discrete
variable groupl.

c. Obtain a factorized boxplot for the variable income, using as factor the discrete
variable group3.

d. Comment on the results.

y
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Example 3.5.4. Factorized boxplots.

To create the discrete variables groupl, group2 and group3, go up to the Menu
Bar and click Add -> Define new variable.

B greti: add var g B8 gretl: add var &
Enter formula for new variable Enter formula for new variable
(or just a name, to enter data manually) (or just a name, to enter data manually)
groupl=(age<=30)| group2=(age>30)&&(age<=40)|
Help ] [ Cancel ] [ oK [ Help ] [ Cancel ] [ OK
EA gretl: add var e

Enter formula for new variable
(or just a name, to enter data manually)

group3=(age>40)|

oo ) [Comes J[ox ]

Edit the attributes of these variables and mark Treat this variable as discrete.
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Example 3.5.4. Factorized boxplots.

Factorized boxplot (factor groupl). pizza.

B4 grett: graph [ESREE >

Distribution of pizza by group1

600 -

500 -

pizza
w
=}
8
T

0 1
group1
Right-click on graph for menu EeRAZD X
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Example 3.5.4. Factorized boxplots.

Factorized boxplot (factor group3). income.

B oreti: graph Lo ]
Distribution of income by group3
300
250 -
200
©
E isof
£
1
100 N
] '
ol
o 1
group3
Right-click on graph for menu RN JEASE
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Example 3.5.4. rized boxplots.

Results.

e The quantitative variable age is used to factorize the boxplot. Given that the factor
must be a discrete variable, it is necessary to transform the quantitative variable into
a discrete variable. This is done by splitting the variable age into three intervalas
defining three discrete variables: groupl (less than 31 years old), group2 (over 30
years old and less than 41) and group3 (over forty years old).

e Analysing the factorized boxplot of pizza obtained using groupl as factor, it may be
observed that the clients less than 31 years old consume more pizza than the rest of
the individuals in the whole sample (over 30 years old clients): the mean, the median,
the first and the third quartiles are larger for young clients.

e Analysing the factorized boxplot of income obtained using group3 as factor, it may
be observed that the clients over 40 years old have higher income than the rest of the
individuals in the whole sample: the mean, the median, the first and the third
quartiles are larger for these clients.
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Example 3.5.4. Boxplot. Discrete variables.

Questions.

Open the data file pizza.gdt:

a. Create the discrete variable groups that takes the value 1 if the client belongs
to groupl, the value 2 if the client belongs to group2 and the value 3 if the
client belongs to group3.

e groupl: clients who are less than 31 years old.

e group2: clients who are over thirty years old and less than forty one years
old.

e group3: clients who are over forty years old.

b. Obtain a factorized boxplot of pizza and income, using the discrete variable
groups as factor.

c. Comment on the results. Save the changes in the data and the Gretl session.
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Example 3.5.4. Boxplot. Discr

To create the discrete variable groups that takes the value 1 if the client belongs
to groupl, the value 2 if the client belongs group2 and the value 3 if the client
belongs to group3, select the option Define a new variable from the Add
pulldown menu.

gretl: add var S|

Enter formula for new variable
(or just a name, to enter data manually)

groups=groupl+2*group2+3*group3

| Hep || cance |[ ok |

Edit the attributes of this variable and mark Treat this variable as discrete.
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Factorized boxplot (factor groups). pizza.

grett: graph [ESR ]

Distribution of pizza by groups

pizza
w
o
°
T

1 2 3
groups
Right-click on graph for menu B2 X
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Example 3.5.4. Boxplot. Disc

Factorized boxplot (factor groups). income.

gretl: graph [ESHEE>

Distribution of income by groups

300
250 -
200

150 |-

il .
+

]

—

1 2 3

groups
Right-click on graph for menu BN, NEA=R 4

income
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Example 3.5.4. Boxplot. Discrete variables.

Results (I).

Consider the new variable groups as a factor.
e The three discrete variables created before are not useful.

e We have to generate a new discrete variable that encompasses the three
groups considered. Thus, groups takes the value 1 for the clients less than 31
years old, the value 2 for the clients over 30 years old and less than 41, and the
value 3 for the clients over 40 years old.

e We could have chosen any other numerical values for the variable groups, for
instance, 1, 5 and 7. It is only required to assign a different value to each
category.
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Example 3.5.4. Boxplot. Disc variables.

Results (II).

Factorized boxplot of pizza using groups as factor.

e The clients over 40 years old consume the least pizza. It may be observed than the
first and the third quartiles are below those of the rest of the sample. Nevertheless,
since the median of this group is close to the median of group2, it would be
advisable to analyse the confidence intervals.

e The sample means of the individuals in groupl and group2 are very similar.

e The median for clients less than 31 years old is clearly larger than the median for the
rest of the sample. On the other hand, it is close to the median of group2. Even
though the first quartile is slightly larger than the one corresponding to group2, we
do not get the same result for the third quartile.

e Bearing in mind the last two comments, we should consider whether we have chosen
the most appropriate intervals to split the variable age. A better option might have
been to define the first group as the clients less than 33/35 years old. To do that we
should redefine the variable groups and repeat the analysis.

o’
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Example 3.5.4. Boxplot. Disc variables.

Results (111).

Factorized boxplot of income using groups as factor.

e The clients less than 31 years old have the smallest incomes: the sample mean, the
median and the third quartile are much smaller than for the rest of the groups. As a
matter of fact, the third quartile is quite similar to the first quartile of groupl and
group?2.

e The IQ range of groupl is the smallest, meaning that the income of these individuals
is quite similar. There is only one individual (it may be considered an outlier) with an
income close to the sample mean and the median of group2.

e Looking at the minimum and maximum values of income, it may be concluded that
the individuals in group2 present the highest variability. Both the mean and the
median of this group is slightly smaller than the mean and the median of group3.
However, in order to analyse the significance of this result it would be necessary to
use other tools, for instance, the confidence intervals for the median.
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Example 3.5.4. Boxplot. Discr

Results (1V).

Factorized boxplot of income using groups as a factor.

e |t may be observed that, in general, the income of the clients in group3 is higher
than the income of clients in group2: both the median and the sample mean are
higher in group3 than in group2.

e The individual with the largest income in the sample is less than forty one years old.
His/her income is much higher than the sample mean.

e Same as before, it might be advisable to analyse if the age intervals considered here
are adequate. It might be better to redefine the last two age groups.

It may be concluded that it would be better to split the variable age into different
intervals for the variables pizza and income.
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e 3.5.5. Normal Q-Q plot.
@ Visitors to Bilbao.
@ Simulation.
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Example 3.5.5. Normal Q-Q plot. Visitors to Bilbao.

Questions.

Open the data file tourism.gdt.

a. Obtain the Q-Q plot for the the variables SPV and F'V.

b. Comment on the results.
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Example 3.5.5. Normal Q-Q plot. Visitors to Bilbao.

To obtain the normal Q-Q plot, highlight the variable of interest, go up to the
Menu Bar and click

Variable -> Normal Q-Q plot...

P e S
File Tools Data View Add Sample Variable Model Help
tourism.gdt Display values
ID# 4 Variable name 4 Descriptive label Edit attributes L
0 const Set missing value code...
1 TV total number of visi Summary statistics
2 visitors coming froi Normality test _
3RV foreign visitors Frequency distribution...
4  HPIR monthly variation r Estimated density plot... Iscay
5 Pl Spanish Industrial B Boxplot
6 PR annual variation rat| Normal Q-Q plot...

Gini coefficient
Range-mean graph

Time series plot

Panel plot...

Unit root tests >

Correlogram

Periodogram

Eilter »

Monthly: f X-12-ARIMA analysis

@2~ B 8 TRAMO analysis

Hurst exponent
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Example 3.5.5.

In the dialog box, you have to select an option for the plot axis.

“ gretl: Q-Q plot ﬁ

Normal Q-Q plot

© iuse sample mean and variance for normal quantiles:

standardize the data

raw quantiles versus N(0, 1)

Hep | | Conca || ok
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Example 3.5.5. Normal Q-Q plot. Visitors to Bilbao.

Q-Q plot. Variable SPV.

gretl: graph w

Q-Q plot for SPV

T T T T T T T T T

55000

50000 |-

45000 -

40000 -

35000

30000 -

25000 |-

20000 |-

15000 |-

10000 [

5000 -

o 1 L L L L L L L L L
o 5000 1000015000 200002500030000 350004000045000 S000055000
Normal quantiles

Right-click on graph for menu ER=IR HEA=ER
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Example 3.5.5. Normal Q-Q plot. Visitors to Bilbao.

Q-Q plot. Variable FV.

gretl: graph @_&

Q-Q plot for FV
40000 T T T T T T T T

35000

30000

25000

20000

15000

10000

5000

-5000

-10000 1 1 L 1 1 L 1 1
-10000 -5000 o S000 10000 15000 20000 25000 30000 35000

Normal quantiles
Right-click on graph for menu EofdAzZ5 X
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Example 3.5.5. Normal Q-Q plot. Visitors to Bilbao.

Results.

e The observations are far away from the main diagonal in both plots. This
result is clearer for variable F'V. It may concluded that there is no evidence in
these plots that these variables come from a normal distribution.

e The second and third options change the scale of the axis (either ordinate or
abscissa). Nevertheless, the interpretation of the plot is similar: the more
observations are close to the main diagonal of the box, the more evidence in
the sample in favour of the normal distribution.
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Example 3.5.5. Normal Q-Q plot. Simulation.

Questions.

Open the data files you created in the Example 3.5.2 (SimT50.gdt and
SimTlOOO.gdt).

a. Obtain the Q-Q plot for the simulated variable in data file Sim50.gdt.

b. Obtain the Q-Q plot for the simulated variable in data file Sim1000.gdt.

c. Discuss and compare the results.
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Example 3.5.5. Normal Q-Q plot. Simulation.

Q-Q plot (first option). Variable VN.

P [ESHEEE >

Q-Q plot for VN
3 T T T T

Normal quantiles
Right-click on graph for menu = o m 25 R
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Example 3.5.5. Normal Q-Q plot. Simulation.

Q-Q plot (first option). Variable VX.

EH greti: graph [ESNEEE™ >

Q-Q plot for VX
35 T T T T T

-5 o] 5 10 15 20 25
Normal quantiles
Right-click on graph for menu ol Z2S X
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Example 3.5.5. Normal Q-Q plot. Simulation.

Results.

e A visual inspection of the Q-Q plot for variable VN (T=50) shows that it is
not too close to the diagonal in the tails. Even though the variable VN comes
from a normal distribution, the Q-Q plot is unclear and it is risky to reach any
conclusion. This result can be due to the small sample size.

e Analysing the Q-Q plot for variable VX (T=1000), it can be observed that it
moves away from the diagonal in the tails. This result was expected since the
variable VX comes from a x? distribution.

e In short, it may be concluded that the results derived from the normal Q-Q
plots depend on the sample size and they are more reliable for large samples.

e Bear in mind that your simulated data are going to be different from ours.
Therefore, you will obtain different Q-Q plots and your conclusions might be
different.
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